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Note pour les utilisateurs Mac
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chapitre. Pour une liste plus détaillée, voyez dans I'Aide.

Windows/Linux Equivalent Mac Effet

Sélection de menu LibreOffice > Préférences Acceés aux options de paramétrage
Outils > Options

Clic droit F¥+clic Ouvre un menu contextuel

Ctrl (Contréle) ¥ (Commande) Utilisé avec d'autres touches

F5 Maj+3+F5 Ouvre le Navigateur

F11 #E+T Ouvre la fenétre Styles & Formatage
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Eléments graphiques dans Calc

Calc est souvent utilisé pour présenter des données et faire des budgets et des prévisions. Les
éléments graphiques peuvent transformer un document quelconque en un document dont on se
souvient. Calc peut importer différents formats de fichiers vectoriels (dessin de lignes) et matriciels
(bitmap). Les formats graphiques les plus couramment utilisés sont GIF, JPG, PNG et BMP. Voir
I'Aide pour la liste compléte des formats que LibreOffice peut importer.

Les éléments graphiques dans Calc peuvent étre regroupés en trois types :
* les fichiers d'image, comme les photos, les dessins et les images scannées
* les diagrammes créés avec les outils de dessin de LibreOffice
* les diagrammes et graphiques créés par les fonctions Diagrammes de LibreOffice

Ce chapitre couvre les images et les diagrammes. Les graphiques sont décrits Chapitre 3 (Créer
des Diagrammes et des Graphiques).

Bien que l'usage des éléments graphiques dans Calc soit trés similaire a l'usage des éléments
graphiques dans d'autres composants de LibreOffice, ce chapitre explique certaines différences
dans leur utilisation. Il couvre également certaines fonctions graphiques plus avancées et la fagon
dont elles peuvent améliorer en fin de compte votre classeur.

L'expression éléments graphiques se référe a la fois aux images et aux objets
Note dessinés. Souvent le mot images est utilisé pour se référer aux images et autres
éléments graphiques qui ne sont pas des objets dessinés.

Ajouter des images

Les images, comme des logos de sociétés ou des photographies de personnes ou de produits,
sont probablement les types les plus courants d'éléments graphiques ajoutés a un document Calc.
lls peuvent étre téléchargés depuis Internet, scannés ou créés avec des logiciels graphiques ; ou
ce peuvent étre des photos prises avec un appareil numérique.

Les images peuvent étre insérées de quatre manieres :
* en utilisant la boite de dialogue Insérer une image
* en glissant et déposant un fichier reconnu
* depuis la Gallery
* depuis le presse-papiers en copiant et collant

Insérer un fichier image
La maniere la plus ordinaire d'insérer une image est peut-étre d'utiliser un fichier existant.
Pour insérer une image depuis un fichier, utilisez I'une des méthodes suivantes :

* hoite de dialogue Insérer une image
e glisser-déposer

Boite de dialogue Insérer une image

1) Cliquez a I'endroit dans le document Calc ou vous voulez que I'image apparaisse. Ne vous
souciez pas trop du positionnement exact de l'image a cette étape ; 'emplacement pourra
facilement étre changé comme décrit dans “Positionner des éléments graphiques” page 20.
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2) Choisissez Insertion > Image > A partir d'un fichier dans la barre de menus, ou cliquez

sur l'icéne A partir d'un fichier By dans la barre d'outils Image ou Dessin.

3) Dans la boite de dialogue Insérer une image, naviguez jusqu'au fichier a insérer,
sélectionnez le et cliquez sur Ouvrir.

L'image est insérée dans Calc de sorte qu'elle flotte au-dessus des cellules et qu'elle
soit ancrée a la cellule dans laquelle le focus était placé. Voir “Positionner des

Note éléments graphiques” page 20 pour plus d'informations sur le positionnement et
I'ancrage des éléments graphiques.
Insérer une image @
E\Users\CCH\Documents\Libre Office\Calc04 HlEIrRY
Titre Type Taille Date de modification
B Figurel.png Images (png) 9980 Octets 27/02/2012,11:31:26 B . '
|=3 Figurel0.png Images (png) 319 Ko 02/04/2012,10:16:37 B
|=5| Figurell.png Images (png) 149 Ko 02/04/2012, 10:23:56 E 2
|=3 Figurel2.png Images (png) 21,3 Ko 02/04/2012,10:41:42 E
|=5| Figurel3.png Images (png) 09 Ko 02/04/2012, 10:58:26 E
|=3 Figureld.png Images (png) 36,2 Ko 02/04/2012,11:48:10 1 =
|73 Figure2.png Images (png) 244 Ko 27/02/2012,12:22:42 2’?
|=3| Figure3.png Images (png) 135 Ko 29/03/2012,17:19:23 - E
Nom defchir: (e g 5] e e e
Type de fichier: <Tous les formatss (*.bmp;*.dxf;*.emf;*.eps;*.gif;*.jpg;*.jpEl T i [ A eaculiar - SR R cabuks
Aide
Lier 1 Apercu

Figure 1 : Insérer une image depuis un fichier

En bas de la boite de dialogue se trouvent deux options, Apercu et Lier. Sélectionnez Apergu
pour afficher un apercgu de I'image sélectionnée sur la droite, ce qui vous permet de vérifier qu'il
s'agit du bon fichier. L'option Lier est détaillée page 6. Quand I'option Lier n'est pas cochée,
I'image est incorporée dans le document Calc.

Votre boite de dialogue Insérer une image peut étre sensiblement différente de celle
Note de la Figure 1, selon votre systeme d'exploitation et votre choix dans Outils >
Options > LibreOffice > Général d'utiliser les boites de dialogue LibreOffice.

Glisser-déposer
1) Ouvrez une fenétre d'exploration de fichiers et trouvez I'image que vous voulez insérer.
2) Faites glisser I'image dans le document Calc et déposez-la a I'endroit ou vous voulez
gu'elle apparaisse. L'image est ancrée a la cellule dans laguelle elle a été déposée.

Cette méthode incorpore (enregistre une copie de) toujours le fichier image dans le document
Calc.
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Lier un fichier image

Pour créer un lien vers le fichier qui contient I'image au lieu d'en enregistrer une copie dans le
document Calc, utilisez la boite de dialogue Insérer une image et cochez I'option Lier. Un
message d'avertissement peut apparaitre pour vous demander de confirmer cette liaison ou
d'incorporer le fichier. L'image est alors affichée dans le document, mais quand le document est
enregistré, il contient seulement une référence au fichier image, et non l'image elle-méme. Le
document et I'image demeurent dans deux fichiers séparés, qui seront fusionnés temporairement
uniquement quand vous ouvrirez a nouveau le document.

Lier une image comporte deux avantages et un inconvénient :

Note

Avantage : vous pouvez modifier le fichier image séparément sans changer le document,
parce que le lien vers le fichier reste valide, et 'image modifiée apparaitra la prochaine fois
gue vous ouvrirez le document. Ce peut étre un grand avantage si vous (ou quelqu'un
d'autre, un graphiste par exemple) mettez a jour les images.

Avantage : le lien peut réduire significativement la taille du document au moment de son
enregistrement, parce que le fichier image lui-méme n'est pas inclus. La taille de fichier
n‘est habituellement plus un probleme sur les ordinateurs modernes qui ont une mémoire
de stockage conséquente, a moins que le document ne comporte de trés gros fichiers
graphiques. Calc peut supporter de gros fichiers.

Inconvénient : Si vous envoyez le document a quelgu'un d'autre, ou si vous le déplacez
vers un autre ordinateur, vous devez également envoyer les fichiers image, ou le
destinataire ne pourra pas voir les images liées. Vous devez garder une trace de
I'emplacement des images et vous assurer gue le destinataire sache ou les déposer sur
une autre machine, pour que le document Calc puisse les retrouver. Par exemple, vous
pouvez conserver les images dans un sous-dossier appelé Images (dans le dossier qui
contient le document Calc) ; le destinataire du fichier Calc devra déposer les images dans
un sous-dossier qui porte le méme nom (dans le dossier qui contient le document Calc).

Si vous insérez la méme image plusieurs fois dans un document, vous pouvez
penser qu'il est intéressant de créer des liens. Cependant, ce n'est pas
nécessaire, parce que LibreOffice n'incorpore qu'une copie du fichier image dans
le document. (La suppression d'une ou plusieurs copies n'affecte pas les autres.)

Incorporer des images liées

Si vous aviez au départ lié les images, vous pouvez facilement les incorporer (enregistrer dans le
document Calc) par la suite si vous le souhaitez, en totalité ou en partie. Pour ceci :

1)
2)

3)

Ouvrez le document dans Calc.
Choisissez Edition > Liens dans la barre de menus.

La boite de dialogue Editer les liens liste tous les fichiers liés. Dans la liste Fichier source,
sélectionnez les fichiers que vous voulez madifier de lié a incorporé.

Cliquez sur le bouton Rompre le lien.
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Editer les liens @
Fichier source Elément : Type Statut [ Fermer ]
Figurel.png PMG - Portable Metwork Image Manuel
Figureld.png PMG - Portable Metwork Image Manuel [ Aide ]
[ Actualiser ]
| Modifier.. |
[ Rompre le lien ]

Fichier source file:/(/E:/Users/CCH/Documents/Libre Office/Figurel .png

Elément : PMG - Portable Metwork Graphic

Type: Image

Actualiser: Automatique @ Manuel

Figure 2 : Boite de dialogue Editer les liens

Aller dans l'autre sens, d'incorporé a lié, n'est pas aussi facile : vous devez

Note supprimer et réinsérer chaque image, une a la fois, en cochant l'option Lier.

Insérer une image depuis le presse-papiers

Avec le presse-papiers, vous pouvez copier des images dans un document Calc depuis un autre
document Calc, un autre composant de LibreOffice (Writer, Draw, ...), ainsi que des programmes
tiers.
Pour ceci :

1) Ouvrez a la fois le document source et le document Calc ol vous voulez copier l'image.

2) Dans le document source, sélectionnez l'image a copier.

3) Appuyez sur Ctrl+C pour copier I'image dans le presse-papiers.

4) Basculez dans la fenétre Calc.

5) Cliquez pour placer le focus a I'endroit ou I'image doit étre insérée.

6) Appuyez sur Ctrl+V pour insérer l'image.

Attention  SiI'application depuis laquelle I'élément graphique est copié est fermée avant que
AN cet élément soit collé dans Calc, il peut arriver que l'image stockée dans le presse-
/ papiers soit perdue.

Insérer une image depuis la Gallery

La Gallery regroupe de fagon pratique des objets réutilisables, comme des éléments graphiques
OU sonores, que vous pouvez insérer dans vos documents.

La Gallery est disponible dans tous les composants de LibreOffice. Elle n'est pas fournie avec
beaucoup d'éléments graphiques, mais vous pouvez ajouter vos propres images ou trouver des
extensions qui contiennent plus d'éléments. La Gallery est expliquée en détail dans le Chapitre 11
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(Eléments Graphiques, Gallery et Fontwork) du Guide du débutant. Pour plus d'informations sur
les extensions, voir le Chapitre 14 (Paramétrer et Personnaliser Calc) dans ce guide.

Cette section expligue les bases de l'insertion d'images de la Gallery dans un document Calc.

1) Pour ouvrir la Gallery (Figure 4), cliqguez sur l'icbne Gallery (située du c6teé droit de la
barre d'outils Standard) ou choisissez Outils > Gallery dans la barre de menus.

2) Naviguez dans la Gallery pour trouver I'image désirée.

3) Pour insérer I'image, faites un clic droit sur I'image et choisissez Ajouter > Copier, ou
cliguez et faites glisser I'image depuis la Gallery jusqu'a I'endroit désiré au sein du
document Calc en cours.

Par défaut, la Gallery est ancrée au-dessus de I'espace de travail de Calc. Pour étendre la Gallery,
positionnez le curseur au-dessus de la ligne qui la sépare du haut de I'espace de travail. Quand le
pointeur devient un symbole avec des lignes paralléles et des fleches, cliquez et faites glisser vers
le bas. L'espace de travail est redimensionné en conséquence.

Pour étendre la Gallery sans modifier I'espace de travail, enlevez I'ancrage pour qu'elle flotte au-
dessus de I'espace de travail. Pour ce faire, gardez appuyée la touche Citrl et double-cliquez en
haut de la Gallery prés des icbnes d'affichage, ou appuyez sur la combinaison de touches
Ctrl+Maj+F10. Renouvelez I'opération pour I'ancrer a nouveau (la ramener a sa position initiale au-
dessus de I'espace de travail).

Quand la Gallery est ancrée, pour la masquer et voir I'espace de travail en entier, cliqguez sur le
bouton Masquer/Afficher au milieu de la ligne séparant la Gallery de I'espace de travail (cerclé
Figure 4).

Pour fermer la Gallery, choisissez Outils > Gallery pour dé-sélectionner la ligne Gallery, ou cliquez
a nouveau sur l'icbne Gallery.

B-EBrie @ BER YE KE®- ERTR ﬂ:@-@-:

: [8d Par défaut (=] |Arial « w0 [+ 6 7§

g B of
db % a3

MNouveau théme... (28 | E=] Arriére-plans - marble (E:\Program Files (xB6)\LibreOffice 3.5\program\..\share\gallery\ww

= Mon théme 2
Page d'accueil
Puces

Régles

Sons

ODOCOOD

‘cn‘m.hl_um J E

Figure 3 : Gallery dans Calc
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Modifier des images

Quand vous insérez une nouvelle image, vous pouvez avoir besoin de la modifier afin de I'adapter
a votre document. Cette section décrit l'utilisation de la barre d'outils Image, le
redimensionnement, le rognage et une astuce pour faire pivoter une image. Les maodifications
faites dans Calc n'affectent pas l'image d'origine, qu'elle soit incorporée ou liée.

Calc fournit plusieurs outils pour travailler avec les images. Ces outils sont suffisants pour les
besoins ordinaires de la plupart des utilisateurs. Cependant, pour obtenir des résultats
professionnels, il est préférable d'utiliser un programme de manipulation d'images tel que GIMP
pour modifier les images (par exemple, pour rogner, re-dimensionner, faire pivoter et changer les
valeurs de couleurs) et ensuite insérer le résultat dans Calc. GIMP est un programme graphique
libre qui peut étre téléchargé depuis http.//www.gimp.org/downloads/.

Utiliser la barre d'outils Image

Quand vous insérez une image ou en sélectionnez une déja présente dans le document, la barre
d'outils Image apparait. Vous pouvez la paramétrer pour qu'elle soit toujours présente (Affichage
> Barre d'outils > Image). Les boutons de contréle d'image de la barre d'outils Image peuvent
également étre ajoutés a la barre d'outils Standard. Voir Chapitre 14 (Paramétrer et Personnaliser
Calc) pour plus d'informations.

Cette barre d'outils peut étre soit flottante, soit ancrée. La Figure 4 montre la barre d'outils Image
flottante. Une courte explication des outils est fournie dans la Table 1. Voir le Guide Draw pour des
explications plus détaillées.

Deux autres barres d'outils peuvent étre ouvertes depuis celle-ci : la barre d'outils Filtre graphique,
qui peut étre détachée et placée n'importe ou dans la fenétre, et la barre d'outils Couleur, qui
s'ouvre en tant que barre d'outils flottante séparée.

Avec ces trois barres d'outils, vous pouvez appliquer de petites corrections aux éléments
graphigues ou obtenir des effets spéciaux.

Image *
B N Parddaut (<] Bl Rox B A0 @m B & O E k-

Figure 4 : Barre d'outils Image
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Table 1. Fonctions de la barre d'outils Image (de gauche a droite)

Ic6ne

Yy

-
st [5]
=

=)
=]
g8
Ak

[]

B O 6 K

[

e -

Nom
A partir d'un
fichier

Filtrer
Mode Graphique

Couleur

Transparence

Ligne

Remplissage

Ombre

Rogner l'image

Changer
d'ancrage

Envoyer a l'avant

Envoyer a
l'arriére
Au premier

plan/A l'arriére-
plan

Alignement

Choisir un mode graphique

Vous pouvez changer la couleur des images en niveaux de gris en sélectionnant l'image, puis en
sélectionnant Niveaux de gris dans la liste Mode Graphique.

Effet
Utilisez cette icbne comme indiqué dans “Insérer un
fichier image” page 4.

Affiche la barre d'outils Filtre graphique. Voir page 11.

Comporte plusieurs modes de couleur dans la liste
déroulante. Voir page 10.

Ouvre la barre d'outils Couleur, décrite page 12.

Détermine la transparence de l'image sélectionnée. Voir
page 12.

Ajuste le style de bordure de I'image sélectionnée.

Remplit la zone avec la couleur ou le motif
sélectionnés.

Ajoute une ombre aux c6tés de l'image.

Ouvre la boite de dialogue Rogner, ou vous pouvez
supprimer une partie sélectionnée de l'image. Voir page
12.

Bascule entre I'ancrage de l'image a la cellule ou a la
page. Voir page 21.

Envoie l'image sélectionnée sur le dessus de la pile.
Voir page 20.

Pousse l'image sélectionnée au fond de la pile. Voir
page 20.

Permet a I'image de flotter au premier plan ou de faire
partie de l'arriere-plan (derriere les cellules). Voir page
20.

Si deux images ou plus sont sélectionnées, ajuste
l'alignement des images horizontal ou vertical entre
elles. Voir page 22.

10
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Table 2. Modes graphiques

Mode Graphique Effet
Par défaut Conserve l'image telle qu'elle a été insérée.
Niveaux de gris Affiche lI'image avec des niveaux progressifs de gris.
Noir/Blanc Convertit I'image en une image monochromatique noire et blanche.
Filigrane Transforme I'image en un filigrane qui se fond dans l'arriere-plan.
Utiliser les filtres graphiques
graphiq %, 7| |Par défaut
Cliquez sur l'icbne Filtrer h pour afficher la barre d'outils Filtre graphique, CRVAR
qui fournit des outils pour appliquer des filtres élémentaires de photographie et ==
d'effets aux images depuis Calc. Pour détacher cette barre d'outils et la placer _
n'importe ou sur I'écran, cliquez sur les trois lignes paralléles et faites glisser. & 5] &
Table 3. Filtres graphiques et leurs effets o
Icébne  Nom Effet
< Invertir Inverse les couleurs de lI'image a la fagon d'un négatif.
0 Adoucir Applique un flou gaussien a I'image pour en adoucir les arétes.
Jf_\s Augmgnter la Augmente la netteté de I'image.
nettete
j[ _Supp(lmer les Appligue une grossiére réduction de bruit.
- interférences
o Inverse certaines tonalités, ce qui produit un soulignement accentué
Solarisation -
des zones en évidence.

Vieillissement Appligue un filtre sépia.

u s

Ouvre une boite de dialogue pour déterminer le nombre de couleurs a
- Poster postériser. Cet effet repose sur la réduction du nombre de couleurs. Il
fait ressembler des photos & des peintures.

.: Pop'art Applique un style Pop Art & I'image.

V4 E;Sa?r;n au Appligue un style de dessin au fusain a I'image.

EI Ouvre une boite de dialogue pour créer des reliefs. Vous pouvez
Relief choisir la position de la source de lumiére imaginaire qui détermine le

type d'ombre.

Assemble de petits groupes de pixels en zones rectangulaires de
l;" Mosaique méme couleur. Plus les rectangles sont grands, moins I'image
graphique a de détails.
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Appliquer consécutivement plusieurs filtres d'image LibreOffice aura pour
conséquence la dégradation progressive de la qualité de l'image. Les filtres
d'image de Calc utilisent des algorithmes dits destructifs, avec lesquels chaque

Attention filtre est appliqué a I'image immédiatement, changeant ainsi les données d'origine.
Des transformations successives conservent de moins en moins les données de
départ, ce qui compromet la qualité de I'image insérée. Ce peut étre acceptable

pour des documents simples, mais l'usage de logiciels spécialisés dans I'édition
de photos et d'images est vivement recommandé pour des manipulations plus
complexes.

Couleur *

Ajuster les couleurs

Fox |5

Utilisez la barre d'outils Couleur pour ajuster indépendamment les canaux rouge, _ .

vert et bleu de l'image, ainsi que sa luminosité, son contraste et son gamma. T 0% |5

o =o% |5
Définir la transparence

0% |+

- 0% (2

Modifier la valeur de pourcentage dans le champ Transparence ? dela &) 0%
barre d'outils Image va rendre l'image plus ou moins transparente. Ce peut étre utile =
quand vous créez un filigrane ou lorsque vous déplacez une image en arriére-plan. | L 1,00

[k

[k

Personnaliser les lignes, les remplissages et les ombres

Les icones Ligne, Remplissage et Ombre ouvrent des boites de dialogue ou vous pouvez
personnaliser ces éléments. Les détails sont dans le Guide Draw.

Rogner les images

Si vous étes intéressé seulement par une partie de l'image pour I'objectif de votre document, vous
pouvez vouloir en rogner (couper et enlever) certaines parties. L'interface utilisateur de Calc pour
rogner une image n'est pas trés évidente, et il est peut-étre plus judicieux d'utiliser un logiciel
graphique.

Cliquez sur l'icone Rogner lI'image & pour ouvrir une boite de dialogue ou vous pouvez
sélectionner une portion de l'image a afficher.

Il n‘est pas possible d'utiliser la souris pour sélectionner la zone a rogner, comme vous pouvez le
faire dans Draw. Au lieu de ¢a, dans la boite de dialogue Rogner, spécifiez a quelle distance des
bordures du haut, du bas, de gauche et de droite de I'image le rognage doit avoir lieu, comme
illustré Figure 5. Dans l'apergu, notez que la sélection aprés rognage est mise en évidence avec
un rectangle.

Dans la boite de dialogue Rogner, vous pouvez contrbler les parametres suivants :

Conserver I'échelle | Conserver la taille de I'image
Quand Conserver I'échelle est coché (par défaut), le rognage de lI'image ne change pas son
échelle.

Quand Conserver la taille de I'image est coché, le rognage élargit (pour les valeurs de
rognage positives), comprime (pour les valeurs de rognage négatives) ou distord I'image pour
que sa taille reste inchangée.
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Gauche, Droite, Haut et Bas
L'image est rognée de la quantité saisie dans ces champs. Par exemple, une valeur de 3cm
dans le champ Gauche enléve 3 cm du cété gauche de lI'image.

* Quand Conserver I'échelle est coché, la taille de I'image change également ; dans cet
exemple, la largeur est réduite de 3 cm.

* Quand Conserver la taille de I'image est coché, la partie restante de I'image est élargie
(quand vous saisissez des valeurs de rognage positives) ou comprimée (quand vous
saisissez des valeurs de rognage négatives) pour que la largeur et la hauteur de l'image
restent inchangées.

Reogner X

Rogner

gﬂ Conszerver |'échelle M
Conserver la taille de I'image | Annuler |

Gauche 0,00cm = Haut 0.00cm = |T|
Droite 1.58cm = Bas 0,00cm =

Echelle
Largeur |105% =

Hauteur | 100%

4|k

Taille de l'image
15,88em=11,91cm (96 PPI)

4k

Largeur 1501cm

Hauteur 11,95¢m Taille d'origine

4k

Figure 5 : Boite de dialogue Rogner

Largeur et Hauteur
Les champs Largeur et Hauteur sous Echelle ou Taille de Iimage se modifient en fonction des
valeurs des champs Gauche, Droite, Haut et Bas. Utilisez I'apercu a cété de ces champs pour
déterminer les valeurs correctes avec lesquelles rogner l'image.

La forme rognée est toujours un rectangle ; les formes plus complexes ne sont pas possibles avec
Calc. Si vous en avez besoin, utilisez un logiciel spécialisé dans I'édition de photos et d'images,
puis importez I'image dans Calc.

Si vous rognez une image dans Calc, l'image elle-méme n'est pas modifiée. Si
Note vous exportez le document en HTML, l'image d'origine est exportée, et non l'image
rognee.
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Re-dimensionner une image

Pour re-dimensionner une image :

1) Cliguez sur l'image, si nécessaire, pour afficher les poignées vertes de re-
dimensionnement.

2) Positionnez le pointeur de la souris au-dessus d'une de ces poignées vertes. Le pointeur
se change en une forme qui donne une représentation graphique (fleche double) de la
direction du re-dimensionnement.

3) Cliquez et faites glisser pour re-dimensionner l'image.
4) Relachez le bouton de la souris quand vous étes satisfait de la nouvelle dimension.

Les poignées de coin re-dimensionnent a la fois la largeur et la hauteur d'un objet graphique
simultanément, tandis que les quatre autres poignées ne changent qu'une dimension a la fois.

Pour conserver les proportions d'origine de I'élément graphique, utilisez Maj+clic
Astuce sur l'une des poignées de coin, puis faites glisser. Faites attention de relacher le
bouton de la souris avant de relacher la touche Maj.

Re-dimensionner une image bitmap (matricielle) comme une photo affecte négativement sa
résolution, en provoquant un certain flou. Il est préférable d'utiliser un logiciel spécialisé pour
dimensionner correctement votre image avant de l'insérer dans votre document, si c'est possible.

Pour un re-dimensionnement plus précis, utilisez la boite de dialogue Position et taille, comme
décrit page 15.

Faire pivoter une image

Calc ne fournit pas d'outil pour faire pivoter une image, mais vous pouvez utiliser cette astuce :
1) Ouvrez un nouveau document Draw ou Impress.
2) Insérez l'image que vous voulez faire pivoter.
3) Sélectionnez l'image, puis, dans la barre d'outils Dessin (habituellement en bas de la

fenétre Impress ou Draw), sélectionnez I'icone Effets @.

4) Faites pivoter I'image comme vous le souhaitez. Utilisez les poignées rouges dans les
coins de l'image et déplacez la souris dans la direction dans laquelle vous voulez effectuer
la rotation. Par défaut, I'image pivote autour de son centre (indiqué par un réticule noir),
mais vous pouvez modifier le point de pivot en déplacant le réticule noir comme vous le
souhaitez.

Pour restreindre I'angle de rotation & des multiples de 15 degrés, gardez appuyée

Astuce la touche Maj pendant la rotation de I'image.

5) Sélectionnez l'image pivotée en appuyant sur Ctrl+A, puis copiez cette derniére dans le
presse-papiers avec Ctri+C.

6) Allez enfin dans le document Calc, placez le focus ou l'image doit étre insérée et appuyez
sur Ctrl+V.

14 Utiliser des Eléments graphiques dans Calc



Utiliser le menu contextuel d'une image

Beaucoup d'options accessibles depuis la barre d'outils Image peuvent également étre atteintes en
faisant un clic droit sur I'image pour ouvrir un menu contextuel. Des options supplémentaires ne
sont disponibles que dans ce menu ; elles sont décrites dans cette section.

Texte

Ouvre une boite de dialogue ou vous pouvez paramétrer les options pour le texte qui recouvre
I'image. Pour écrire un texte sur un élément graphique, cliquez sur ce dernier afin de le
sélectionner et appuyez sur Entrée (ou double-cliquez). Un curseur apparaitra alors au centre de
cet élément graphique. Tout texte saisi fera partie intégrante de cet ensemble graphique ; de ce
fait, si ce dernier est déplacé, le texte le suivra.

Position et taille

Ouvre la boite de dialogue ci-dessous, ou vous pouvez changer la taille, la position, la rotation,
l'inclinaison et le rayon d'angle de l'image.

Position et taille ==
Position et taille |F‘.ntatinn IInr_Iinaimn et rayon d'angle
Pesition
Point de base
Position X 0,20cm : T
" f'“ "
Fosition ¥ 0,00cm = | |
F—
Taille
Point de base
= > {—
Largeur 17.06cm - T |
£ f‘“ i
Haut . I I
Hauteur 1 46ecm - ~ ~ -~
Propertionnel
Protéger Adapter
Positicn Adapter la largeur au texte
Taille Mdapter la hauteur au texte

Figure 6 : Boite de dialogue Position et taille

Description

Vous pouvez ajouter, en tant que méta-données, un titre et une description a l'image. Cette
information est utilisée par les outils d'accessibilité (comme un logiciel de lecture d'écran) et en
gualité d'attributs de type ALT (alternatifs) si vous exportez le document en HTML.

Nom

Vous pouvez affecter un nom personnalisé a l'image, pour pouvoir la retrouver plus facilement
dans le Navigateur.
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Si vous collaborez a une équipe pour une vaste publication multi-pages, il peut étre
Astuce intéressant de donner aux éléments graphiques et autres objets des noms et des
descriptions significatifs pour contribuer a une meilleure communication.

Refléter

Refléte l'image horizontalement ou verticalement.

Assigner une macro

Ajoute une fonctionnalité programmée a l'image. Calc fournit de riches fonctionnalités de macros.
Les macros sont présentées Chapitre 12 (Macros Calc).

Groupe

Pour regrouper des images :

1) Sélectionnez une image, puis gardez appuyée la touche Maj et cliquez sur chacune des
autres images que vous voulez inclure dans le groupe. Le “cadre de sélection” invisible
(avec les huit poignées vertes) s'étend pour inclure toutes les images sélectionnées.

2) Une fois les images sélectionnées, choisissez Format > Grouper > Grouper dans la barre
de menus, ou placez le pointeur de la souris au-dessus de I'une des images et, quand le
pointeur n'a plus lI'apparence d'une fleche mais d'une fleche a quatre pointes, faites un clic
droit et choisissez Groupe > Grouper dans le menu contextuel.

Une fois les images regroupées, le menu contextuel fournit d'autres options (Dissocier et Editer
le groupe) ainsi que le menu Format > Grouper qui comprend Dissocier et Entrer dans le
groupe. Pour plus d'informations sur le regroupement, voir le Guide Draw.

Utiliser les outils de dessin de Calc

Calc, comme les autres composants de LibreOffice, recéle toute une palette d'outils pour créer des
dessins personnalisés. Ce chapitre couvre les options par défaut dans Calc. Pour une explication
plus détaillée des outils de dessin et de leurs utilisations, voir le Guide Draw.

Généralement, si vous avez besoin de créer des dessins complexes, il est recommandé d'utiliser
LibreOffice Draw ou un autre programme de dessin.

Pour commencer a utiliser les outils de dessin, choisissez Affichage > Barres d'outils > Dessin.
La barre d'outils Dessin apparait en bas de I'écran. Vous pouvez la détacher et la déplacer a un
endroit plus rationnel dans la fenétre.

35

=

' Feuillel /Feuille2 Feuille3 /4 /|| « m
h /T Hed TR -0 -«-E - -%- ] &

Figure 7 : Barre d'outils Dessin avec les icbnes par défaut
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Table 4. Fonctions de la barre d'outils Dessin (de gauche a droite)

I

cOne

3
/
=

= & @

f)

9 8B ¢ @ ©

g ® B

R| =

Nom

Sélectionner

Ligne

Rectangle

Ellipse

Ligne a main levée
Texte

Légende

Formes de base

Formes des
symboles

Fleches pleines
Organigrammes
Légendes
Etoiles

Points

Galerie Fontwork

A partir d'un fichier

(Dés)activer
I'extrusion

Effet

Sélectionne des objets.

Dessine une ligne.

Dessine un rectangle. Pour dessiner un carré, appuyez sur
Maj pendant que vous faites glisser.

Dessine une ellipse. Pour dessiner un cercle, appuyez sur
Maj pendant que vous faites glisser.

Dessine une ligne a main levée.

Ajoute une boite de texte sans bordure.

Dessine une ligne terminée par un rectangle de légende.

Ouvre la barre d'outils Formes de base.

Ouvre la barre d'outils Formes des symboles.

Ouvre la barre d'outils de formes Fléches pleines.

Ouvre la barre d'outils de formes Organigrammes.

Ouvre la barre d'outils de formes Légendes.

Ouvre la barre d'outils de formes Etoiles.

Permet de modifier les points d'un polygone sélectionné.

Ouvre la Galerie Fontwork.

Insére une image avec la boite de dialogue Insérer une
image.

Ouvre la barre d'outils Paramétres 3D et convertit la forme
sélectionnée (si possible) en 3D.

Utiliser les outils de dessin de Calc
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Pour afficher d'autres icones, faites un clic droit sur la barre d'outils, sélectionnez Boutons
visibles et choisissez les outils que vous voulez voir apparaitre dans la barre d'outils.

Ic6ne Nom Effet

Dessine une ligne composée d'une série de segments droits.
Polygone Gardez appuyée la touche Maj pour positionner les nouveaux
points a des angles de 45 degrés.

.ff‘ Courbe Dessine une courbe de Bézier.

4] Arc dellipse Dessine un arc.

Dessine une forme remplie définie par I'arc d'un ovale et deux
lignes d'angle dans le document courant. Pour dessiner un

& Secteur d'ellipse secteur circulaire, appuyez sur Maj pendant que vous faites
glisser.
Dessine une forme remplie définie par un arc d'ellipse et une
Q Seament de cercle ligne de diametre dans le document courant. Pour dessiner
9 un segment de cercle, appuyez sur Maj pendant que vous
faites glisser.
:}% Animation de texte Insere un texte animé.

Si la prise en charge des langues asiatiques est activée (dans Outils > Options > Paramétres
linguistiques > Langues), deux outils supplémentaires peuvent étre ajoutés a la barre d'outils
Dessin : Texte vertical et Légende verticale.

Pour utiliser un outil de dessin :

1) Cliguez dans le document a I'endroit ol vous voulez que le dessin soit ancré. Vous pourrez
changer I'ancre plus tard, si nécessaire.

2) Sélectionnez l'outil dans la barre d'outils Dessin (Figure 7). Le pointeur de la souris se
transforme en une croix.

3) Déplacez le pointeur a I'endroit dans le document ou vous voulez que le dessin apparaisse
et glissez-déposez pour créer |'objet de dessin. Relachez le bouton de la souris. (Certains
outils ont d'autres impératifs : voir I'Aide ou le Guide Draw pour les détails.)

La fonction de dessin sélectionnée reste active, et vous pouvez donc dessiner d'autres
objets du méme type.

4) Pour arréter la fonction de dessin sélectionnée, appuyez sur la touche Echap ou cliquez
sur l'icdbne Sélectionner (la fleche) de la barre d'outils Dessin.

5) Vous pouvez alors changer les propriétés (couleur de remplissage, type et épaisseur de
ligne, ancrage et autres) de I'objet de dessin en utilisant soit la barre d'outils Propriétés de
I'objet de dessin (Figure 8), soit les sélections et boites de dialogues atteintes en faisant un
clic droit sur l'objet de dessin.

Paramétrer ou changer les propriétés des objets de dessin

Pour paramétrer les propriétés d'un objet de dessin avant de le dessiner :
1) Dans la barre d'outils Dessin (Figure 7), cliquez l'outil Sélectionner.

2) Dans la barre d'outils Propriétés de I'objet de dessin (Figure 8), cliquez sur l'icone de
chaque propriété et choisissez la valeur que vous voulez.
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Ces propriétés par défaut s'appliquent uniquement au document et a la session en cours. Elles ne
sont pas mémorisées quand vous fermez le document, et elles ne s'appliquent pas aux autres
documents. Les propriétés par défaut s'appliquent a tous les objets de dessin, sauf les objets
textes.

Pour modifier les propriétés d'un objet de dessin existant, sélectionnez cet objet et continuez
comme indiqué ci-dessus.

D'autres outils et méthodes pour modifier et positionner des éléments graphiques sont décrits dans
“Positionner des éléments graphiques” ci-dessous.

8 = - ——=| |000em (2] [Moric  [v] @ |Couleur [+]]Bleus ~| &g 268 E fpd-
1 I I N~ | N Y |
12 3 4 5 6 7 g8 91011 12 13
1 Ligne 5 Couleur de ligne 9 Changer d'ancrage 13 Alignement

2 Style de fleche 6 Remplissage 10 Envoyer a l'avant

3 Style de ligne 7 Style de remplissage 11 Envoyer a l'arriére

4 Largeur de ligne 8 Tourner 12 Au premier plan/A l'arriére-plan

Figure 8 : Barre d'outils Propriétés de l'objet de dessin

Re-dimensionner un objet de dessin

Sélectionnez I'objet, cliquez sur I'une des huit poignées qui I'entourent et faites la glisser jusqu'a sa
nouvelle dimension. Pour un re-dimensionnement a I'échelle, sélectionnez I'une des poignées de
coin et gardez appuyée la touche Maj pendant que vous faites glisser la poignée.

Pour un contréle plus précis de la taille de I'objet, utilisez la boite de dialogue Position et taille (voir
“Position et taille” page 15) pour paramétrer la largeur et la hauteur indépendamment. Si l'option
Proportionnel est cochée, alors les deux dimensions changeront en méme temps pour que la
proportion soit maintenue, permettant ainsi un re-dimensionnement calculé a I'échelle.

Grouper des objets de dessin

Pour grouper des objets de dessin :

1) Sélectionnez un objet, puis gardez appuyée la touche Maj et sélectionnez les autres objets
que vous voulez inclure dans le groupe. Le cadre de sélection s'étend pour inclure tous les
objets sélectionnés.

2) Une fois les objets sélectionnés, placez le pointeur de la souris au-dessus de I'un des
objets et choisissez Format > Grouper > Grouper dans la barre de menus ou faites un
clic droit et choisissez Groupe > Grouper dans le menu contextuel.
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Positionner des éléments graphiques

Les éléments graphiques peuvent étre positionnés dans LibreOffice Calc pour se combiner et
construire des éléments plus complexes.

Organiser des éléments graphiques

Les éléments graphiques dans un document Calc sont organisés d'une maniére identique a une
pile de cartes a jouer. Si vous ajoutez des images supplémentaires au document, chaque image
occupe une nouvelle couche au sommet de la pile. Pour organiser les éléments graphiques, vous
devez dire a Calc de changer I'ordre des couches dans la pile.

Figure 9 : Effet de disposition des couches

Calc dispose de quatre options de base pour réorganiser la disposition des images. Ces options
sont accessibles par la barre d'outils Image et par le menu contextuel Disposition de l'image :

Envoyer a l'avant
Place I'image au sommet de tous les autres éléments graphiques ou textes.

Envoyer vers l'avant
Envoie I'image un niveau au-dessus dans la pile (axe Z). Selon le hombre d'objets qui se
recouvrent, vous pourrez avoir besoin d'appliquer cette option plusieurs fois pour obtenir le
résultat désiré.

Envoyer vers l'arriére
L'opposé de Envoyer vers l'avant ; envoie I'image sélectionnée un niveau en-dessous dans la
pile d'objets.

Envoyer a l'arriére
Envoie le graphique sélectionné au niveau le plus bas de la pile, le couvrant ainsi par les
autres éléments (graphiques et textes).

Au premier plan et A I'arriére-plan
Une image ou un objet de dessin peut étre également envoyé a l'arriere-plan. Ce n'est pas la
méme chose que Envoyer vers |'avant ou Envoyer vers l'arriere, qui fixent I'ordre d'un certain
nombre d'éléments graphiques qui se recouvrent. Cette fonctionnalité repousse I'élément
graphique derriere les cellules, ce qui permet de les modifier sans affecter cet élément.

Un élément graphique en arriére-plan a une entrée de menu Au premier plan, au lieu de A
l'arriére-plan.
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Ancrer des éléments graphiques

Les ancres indiquent a un élément graphique comment rester en relation avec les autres éléments.

Ancrer a la page
Ancrer un élément graphique a la page lui permet d'étre positionné a un endroit particulier de la
page. L'élément ne bouge pas quand des cellules sont ajoutées ou supprimées. C'est
I'équivalent d'une référence absolue. L'élément graphique restera toujours en cellule B10 si
c'est la qu'il a été placé.

Ancrer a la cellule
Ancrer un élément graphique a une cellule permet de s'assurer que cet élément restera
toujours avec le contenu auquel il a été associé a l'origine. Si un élément graphique est ancré a
la cellule B10 et une nouvelle ligne est insérée, I'élément graphique sera alors ancré a la
cellule B11. C'est I'équivalent d'une référence relative.

Par exemple, Figure 10, I'image de gauche est ancrée a la cellule B2 (dans laquelle on a saisi XXX
pour indiquer ou l'image est ancrée). L'image de droite est ancrée a la page.

Emmwmm-ﬁ-wul—l

Figure 10 : Ancrage — avant insertion

Si deux lignes sont insérées au-dessus des images, l'image ancrée a la cellule va descendre de
deux lignes et I'ancrage changera. L'image ancrée a la page ne bougera pas. Ceci est illustré
Figure 11. Notez que le symbole d'ancrage et que les XXX sont descendus cellule B4.

A sl C | D | E | F

-"'-L-—-'-'-'

Figure 11 : Ancrage - aprés insertion

Positionner des éléments graphiques 21



Aligner les éléments graphiques

Vous pouvez aligner plusieurs éléments graphiques les uns par rapport aux autres. Pour ceci :

1) Sélectionnez tous les éléments graphiques a aligner (Maj+clic sur chacun). Les éléments
seront entourés par un cadre de sélection avec huit poignées vertes.

2) Dans la barre d'outils Image, cliqguez sur l'icbne Alighement et cliquez sur l'une des six
options.
Ou encore, positionnez le pointeur de la souris au-dessus de I'un des éléments. Quand le
pointeur devient une fleche a quatre pointes, faites un clic droit et choisissez Alighement,
puis l'une des six options.
Parmi les six options, trois concernent l'alignement horizontal (gauche, centré, droite) et trois
concernent l'alignement vertical (en haut, centré, en bas).

Créer une image map

Une image map définit les zones cliquables d'une image, avec des hyperliens vers des adresses
web, d'autres fichiers sur I'ordinateur ou d'autres parties du méme document. Les zones cliquables
sont les équivalents graphiques des textes avec hyperliens. Si vous cliguez dans une zone
cliquable, Calc va ouvrir la page liée avec le programme approprié (par exemple, le navigateur par
défaut pour une page HTML ; LibreOffice Calc pour un fichier .ods ; un lecteur PDF pour un fichier
PDF). Vous pouvez créer des zones cliquables de différentes formes et inclure plusieurs zones
dans la méme image.

Pour utiliser I'éditeur d'image map :
1) Dans votre classeur, sélectionnez lI'image dans laquelle vous voulez définir des zones
cliquables.
2) Choisissez Edition > Image Map dans la barre de menus. L'Editeur d'lmage Map (Figure
12) s'ouvre.

3) Utilisez les outils et les champs de la boite de dialogue décrite ci-dessous pour définir les
zones cliquables et les liens dont vous avez besain.
4) Cliquez sur l'icbne Appliquer 4 pour appliquer les paramétrages.
=]
5) Ceci étant fait, cliguez sur l'icbne Enregistrer il si vous souhaitez enregistrer I'image
map en tant que fichier indépendant, puis cliquez sur la croix dans le coin supérieur droit
pour fermer la boite de dialogue.
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Editeur d'Image Map ==

B L([Ee x 2 B o & &
Adresse: http://fr.librecffice.arg/ Izl
Teute: Aller sur le site web de la communauté francophone Cadre: | _self |Z|
English riFran;a |5u Deutsch

j LibreOffice tatianc

The Document Foundation

http://fr.librecffice.org/ 0,00 crm /0,00 cm 16,22 e x 516 cm

Figure 12 : Boite de dialogue pour créer ou modifier une image map

La zone principale de la boite de dialogue montre l'image dans laquelle des zones cliquables sont
définies. Une zone cliquable est identifiée par une ligne montrant sa forme.

La barre d'outils en haut de la boite de dialogue contient les outils suivants :

Bouton Appliquer : cliquez sur ce bouton pour appliquer les modifications.
Icdnes Ouvrir, Enregistrer et Sélectionner.

Outils pour dessiner une forme de zone cliquable : ces outils fonctionnent de la méme
facon que les outils correspondants dans la barre d'outils Dessin.

Editer, Déplacer, Insérer, Supprimer des points : outils d'édition avancée pour manipuler
la forme d'un polygone de zone cliquable. Sélectionnez I'outil Editer des points pour activer
les autres accessoires.

Icbne Actif : bascule I'état de la zone cliquable sélectionnée de Actif a Inactif.

Macro : associe une macro a la zone cliquable au lieu de lui associer un simple lien
hypertexte.

Propriétés : paramétre les propriétés de I'hyperlien et permet de lui ajouter un attribut
Nom.

Au-dessous de la barre d'outils, précisez pour la zone cliquable sélectionnée :

Adresse : I'adresse pointée par I'hyperlien. Vous pouvez également pointer vers une ancre
dans votre document ; pour le faire, tapez I'adresse dans le format suivant : #nom_ancre
(voir les astuces ci-dessous) .

Texte : saisissez le texte que vous voulez voir apparaitre quand le pointeur de la souris se
trouve au-dessus de la zone cliquable.
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Astuces

Cadre : définit ou la cible de I'nyperlien doit étre ouverte : choisissez entre _blank (ouvre la
cible dans une nouvelle fenétre de I'explorateur), _self (ouvre la cible dans la fenétre de
I'explorateur active), _top ou _parent.

Image Map n'est pas approprié lorsque toute I'image doit étre cliquable et doit pointer
sur un seul lien ; dans ce cas, faites un clic droit sur lI'image puis choisissez
Hyperlien dans le menu contextuel.

L'éditeur Image Map ne dispose pas de navigateur permettant de rechercher et
sélectionner le document cible. Cliquez dans la barre d'outils Standard sur l'outil
Hyperlien, sélectionnez le document, copiez-coller I'Url depuis la boite de dialogue
Hyperlien vers la boite de dialogue Image Map.

La valeur _self pour le cadre de la cible fonctionnera correctement dans la plupart
des cas. Il n'est par conséquent pas recommandé d'utiliser les autres possibilités, a
moins que cela ne soit absolument nécessaire.
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